
PCLinuxOS Magazine Page 1

Volume 110 March, 2016

AAnndd mmoorree iinnssiiddee .. .. ..

LLiinnuuxx AAnnttii OOooppss::

HHooww TToo UUnnddeelleettee FFiilleess

GGIIMMPP TTuuttoorriiaall::

PPoopp--UUpp TTeexxtt
GGaammee ZZoonnee::

BBrreeaacchh && CClleeaarr

AAnn UUppggrraaddee SSttoorryy FFoorr

YYoouurr RReeaaddiinngg PPlleeaassuurree

LLiibbrreeOOffffiiccee 55.. 11:: NNeeww FFeeaattuurreess,, FFaasstteerr LLooaaddiinngg

PPCCLLiinnuuxxOOSS FFaammiillyy

MMeemmbbeerr SSppoottlliigghhtt:: aagguuiillaa



PCLinuxOS Magazine Page 2

Welcome From The Chief Editor

Linux Anti Oops: How To Undelete Files

Screenshot Showcase

LibreOffice 5.1: New Features, Faster Loading

Screenshot Showcase

ms_meme's Nook: Off We Go

An Upgrade Story For Your Reading Pleasure

Screenshot Showcase

Game Zone: Breach & Clear

PCLinuxOS Family Member Spotlight: aguila

Screenshot Showcase

Tip Top Tips: Installing A Newer Version Of

Flash Player Plugin To Older Computers & CPUs

PCLinuxOS Recipe Corner

Screenshot Showcase

GIMP Tutorial: Pop-Up Text

Screenshot Showcase

PCLinuxOS Puzzled Partitions

More Screenshot Showcase

3

5

16

17

20

21

22

24

25

27

28

29

30

31

32

33

34

37

The PCLinuxOS name, logo and colors are the trademark of
Texstar.

The PCLinuxOS Magazine is a monthly online publication
containing PCLinuxOS-related materials. It is published
primarily for members of the PCLinuxOS community. The
magazine staff is comprised of volunteers from the
PCLinuxOS community.

Visit us online at http://www.pclosmag.com

This release was made possible by the following volunteers:

Chief Editor: Paul Arnote (parnote)
Assistant Editor: Meemaw
Artwork: Sproggy, Timeth, ms_meme, Meemaw
Magazine Layout: Paul Arnote, Meemaw, ms_meme
HTML Layout: YouCanToo

Staff:
ms_meme loudog
Meemaw YouCanToo
Gary L. Ratliff, Sr. Pete Kelly
Daniel Meiß-Wilhelm Antonis Komis
daiashi Smileeb

Contributors:
Khadis
oldfrt

The PCLinuxOS Magazine is released under the Creative
Commons Attribution-NonCommercial-Share-Alike 3.0

Unported license. Some rights are reserved.
Copyright © 2015.

Table Of Contents

http://www.pclosmag.com


PCLinuxOS Magazine Page 3

So … what did YOU do during the Great PCLinuxOS
Forum Outage (GPFO) of February, 2016? Did you
have an incurable case of “Forum Withdrawal
(FW)?” Whatever shall you do the NEXT time the
PCLinuxOS Forum goes dark?

The GPFO occurred after a thunderstorm rolled
through the Houston, TX region on February 23,
felling a tree (that looked like it was due to come
down) that then fell into the electrical service pole,
knocking out power to half of Texstar’s house …
which also houses the server that runs the
PCLinuxOS website.

Texstar made the following announcement in the
PCLinuxOS forum, informing the PCLinuxOS
community about the impending power outage:

“Houston we have a problem. A tree fell on the
electrical line coming into the house and bent our
house pole. The electric company will be out
tomorrow to cut power so we can fix the line and the
pole. The website will be offline during this power
outage. If it isn't one thing it is another!”

He went on to add that half of his house was without
power. To keep the PCLinuxOS website up and
running until the power company cut the power for
repairs on the following day, Texstar ran an
extension cord to the “computer room” to supply the
necessary power to keep everything up and running.

Admit it. You find it hard to go without your daily
“forum fix.” It’s ok. You have a LOT of company.
There are many PCLinuxOS users who spend a
considerable amount of time checking to see what
their PCLinuxOS friends and family members are up
to. So … back to our original questions: what did you
do during the February 2016 GPFO? What will you
do the NEXT time the PCLinuxOS Forum goes
dark? C’mon. You know it will happen again,
sometime. So, it’s best to have a plan.

Here are some ideas of things you can do to fill the
time you might have otherwise spent in the
PCLinuxOS forum, had it been up and accessible.

• Visit another Linux OS’s forum. Sure, it probably
isn’t going to be as friendly as the PCLinuxOS
forum, but it might help fill the void. Who knows …
you just may be able to help someone with the
knowledge you gained from running PCLinuxOS.

• Reintroduce yourself to your wife/husband/kids.

• Watch a movie or catch up on the TV series you
skipped out on, because you had to check in on the
PCLinuxOS forum.

• Try out a new recipe you’ve been wanting to try, but
couldn’t find time to. For that matter, try out one of
YouCanToo’s tasty recipes from his monthly
“PCLinuxOS Recipe Corner” column.

• Check in with your “other” friends on social media,
just to let them know that you’re still around and
kicking. While they may not be as fondly viewed as
your PCLinuxOS friends and family members, they’ll
most likely appreciate the effort.

• Start the physical fitness program that you have
kept putting off.

• Work on your “honey do” list, and get a few
projects done around the house. It will go a LONG
way in getting/keeping you out of the proverbial “dog
house.”

• Rediscover one of your old hobbies. You remember
them, right? You know … those things you used to
do before you spent so much time in the PCLinuxOS
forum. Having amnesia? Then start up a new hobby
you’ve been wanting to try (I like making homemade
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wine … it’s very easy and the results are very
rewarding).

• Catalog and organize your vacation photos … from
last year (or the year before).

• Install and try out a new program you’ve always
wondered about, or thought about trying/learning.

See! There are other things you could do when the
PCLinuxOS Forum goes dark.

So, until next month … and the next GPFO … I bid
you peace, happiness, serenity and prosperity.

It's easier than E=mc2

It's elemental
It's light years ahead

It's a wise choice
It's Radically Simple

It's ...
Support PCLinuxOS! Get Your Official

PCLinuxOS
Merchandise Today!

Defending Your Rights

In The Digital World

The PCLinuxOS
Magazine

Created with
Scribus

Welcome From The Chief Editor

http://www.pclinuxos.com
http://www.cafepress.com/pclinuxos
https://www.eff.org/
http://www.scribus.net


PCLinuxOS Magazine Page 5

by Paul Arnote (parnote)

Disaster Scenario #1

You just returned from the vacation of your lifetime. You toured Europe for three
weeks, then stopped for a week at a tropical paradise to cap it all off. Over the
course of a month, you filled up two 16 GiB SD cards with your high resolution
digital SLR camera. Now, it’s time to sit down and transfer, catalog and edit your
images. You even have plans of creating a travelogue for your church group.

During the process of copying all of your images to your computer’s hard drive,
you inadvertently delete all the images on the first SD card.

Oh NO! (Or insert your choice of expletive in place of the “no”). Whatever will you
do? Those pictures are irreplaceable!

Disaster Scenario #2

You’ve been up all night working on a presentation that has to be presented to
the board of directors of the company for which you work in less than 10 hours.
You’ve been working hard on your presentation all night. Now, at 2 a.m., you
decide to raid the refrigerator and grab yourself a late night snack, while taking a
short break – after saving your work. In your absence, the cat decides that the

warm keyboard of your laptop would be
the PURRFECT place to take a nap.
While the cat twirls around to find a
comfortable position in the middle of your
warm laptop, it steps on a combination of
just the right keys and inadvertently
manages to delete your presentation.

There’s no way you can recreate the
presentation in the relatively short
amount of time remaining before you
have to make your presentation.
Whatever will you do? The stakes are
high for your career if this presentation
goes well.

Never fear …

Both of these scenarios are scary to even experienced computer users. I’m sure
you can even think up some other similarly awful scenarios. It is safe to say that
something like this has happened to EVERY computer user out there, at one time
or another.

The key to being able to recover deleted files is to act quickly. Stop what you are
doing immediately. You will want to be able to prevent the data you’re trying to
save from being overwritten, so stopping all other computer activity will help
prevent that from happening. With today’s modern file systems – and even with
file systems from days gone by – the sooner you minimize drive activity, the
greater the chance you will be able to recover any deleted files. Even a small
cookie file from your browser could overwrite an important file that you might wish
to recover.

Windows users have had the ability to “undelete” files for a very long time – say,
from the time when Windows ran atop MS-DOS. But for Linux users, it’s an
especially scary proposition. Linux, for all its glory and all that it gets “right,”
doesn’t have a built-in ability to “undelete” files that were mistakenly deleted. With
Windows, users have little to no choice over file systems, and are pretty much
relegated to using FAT16, FAT32, ExFAT and NTFS file systems. Linux users,
however, can use EXT2, EXT3, EXT4, ReiserFS, BtrFS, and a whole host of
different file systems. Linux users can even use all of the Windows file systems,
too. And this flexibility is most likely at the root of Linux’s lack of a simple, built-in
“undelete” files capability.

Instead, Linux relies on a some utilities that take care of the task of recovering
deleted files, undeleting them, if you will. As far as I know, none of them are GUI,
nor do any of them have GUI frontends. Much to the chagrin of those users who
use GUI programs only, all four of the utilities are command line only programs.
PCLinuxOS has four such utilities in its official repository: ntfsprogs, extundelete,
testdisk and photorec. Let’s take a look at each one.

ntfsprogs

I figure I’d just start out with this one, and get it out of the way. I have no way of
actually testing this one, since I don’t have any NTFS formatted drives. Nor do I
have access to any. (Well, the hospital where I work does use Windows, but I

Linux Anti Oops: How To Undelete Files
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suspect my employment there wouldn’t last too long if I went in there mucking
with their computers. My job is to work on people there, not the hospital’s
computers.) Such are the spoils of declaring yourself “Windows Free.” However,
if you still dual boot with any version of Windows, you may find yourself in need of
this suite of programs specifically designed to work with the NTFS file system.

Here’s what Synaptic has to say about ntfsprogs:

NTFS filesystem libraries and util ities

The Linux-NTFS project aims to bring full support for the NTFS filesystem to the
Linux operating system. Linux-NTFS currently consists of a static library and
utilities. This package contains the following utilities:

ntfscat: concatenate files and print them on the standard output.

ntfsclone: efficiently clone an NTFS filesystem.

ntfscluster: identify files in a specified region of an NTFS volume.

mkntfs: format a partition with the NTFS filesystem.

ntfsfix: tool for fixing NTFS partitions altered by the Linux kernel NTFS
driver.

ntfsinfo: dump a file's attributes.

ntfslabel: display/change the label on an ntfs file system.

ntfsls: list directory contents on an NTFS file system.

ntfsresize: resize an NTFS filesystem.

ntfsundelete: recover a deleted file from an NTFS volume.

It is the last one listed in the suite of utilities that you might be interested in – at
least, when it comes to recovering deleted files.

So, in lieu of actually being able to try it out, the best I can do is refer you to the
man page for ntfsundelete. Well, I can also summarize some of the information
from there, too, and hit the highlights.

ntfsundelete accepts two command line arguments. You can follow with one of
the options (which is optional) and the device to be scanned (required). By
default, ntfsundelete simply scans the specified device for any recoverable files

(specifying the -s option would also tell ntfsundelete to scan the specified device).
It would look like this:

ntfsundelete /dev/sda1

Of course, that’s presuming that /dev/sda1 is formatted with NTFS. Substitute
your NTFS drive or partition for /dev/sda1. The output might look something like
this:

Inode Flags %age Date Size Filename
6038 FN. . 93% 2002- 07- 17 26629 thesis. doc

The scan information reveals the inode of the file, what percentage of the file is
recoverable (in this case, 93%, which is a whole lot better than none of the file),
the date of the file, the size of the file, and the filename. So, to undelete this file,
you would execute the ntfsundelete command as follows:

ntfsundelete - u - m “thesis. doc” - o “thesis. doc” - d ~

Before we explain the command line, just note one thing. Get in the habit of
placing the filename(s) in quotes, just in case there are spaces in the filename(s).
The Linux command line uses spaces as delimiters between options and
command line arguments, so spaces in the filename(s) could cause the
command to fail – unless you put the filename(s) in quotes.

The -u option tells ntfsundelete that you want to undelete a file. The -m option
tells it to look for the file that matches the pattern that follows (in this case, the
filename that appears in quotes). With the -o option, we tell ntfsundelete to name
the output file “thesis.doc” (the same as the “lost” file). Finally, the -d option tells
the program to output the file in the user’s home directory (~).

There are a number of other options available, and they are explained fairly well
on the ntfsundelete man page. For example, you can tell it to scan for files
deleted within the last two days (use the -t 2d option), look for specific types of
files (-s -m “*.pdf”), and so on.

ntfsundelete only reads from the NTFS volume, and never changes the NTFS
volume. It also will not work on compressed or encrypted files. I especially love
the “Caveats” section of the man page. It states “Miracles. ntfsundelete cannot
perform the impossible,” and it then goes on to explain why even files very
recently deleted may not be able to be retrieved in a complete state on NTFS
volumes.

If you routinely work with NTFS volumes, the ntfsprogs suite of programs deserve
a place in your toolbox. Since we’re only dealing with how to undelete files under

Linux Anti Oops: How To Undelete Files
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Linux in this article, you can explore the other utility programs in the suite on your
own.

extundelete

extundelete is a command line utility specifically for undeleting files from Linux
EXT3 and EXT4 file systems. Here is the description from Synaptic:

Extundelete is a command line util ity to undelete files from an ext3 or ext4
partition.

Extundelete is a command line utility to undelete files
from an ext3 or ext4 partition.

The file 'testing.txt' illustrates a simple usage of
this program.

You find it under /usr/share/doc/extundelete-0.2.4/

Before we get to talking about how to run extundelete, note that there is NO
“testing.txt” file in /usr/share/doc/extundelete-0.2.4/, as explained in the
barebones description in Synaptic. Instead, there are brief instructions on how to
run extundelete at the end of the README file. A more complete discussion of
how to run it is explained at its non-standard man page, here. Ubuntu has
created a more formal man page, which can be viewed here.

Simply entering extundelete on the command line by itself also displays a
slimmed down command summary. Here it is:

[parnote- toshiba@parnote- toshiba ~] $ extundelete
No action specified; implying - - superblock.
extundelete: Missing device name.

Usage: extundelete [options] [- - ] device- file

Options:
- - version, - [vV] Print version and exit successfully.
- - help, Print this help and exit successfully.
- - superblock Print contents of superblock in addition

to the rest. If no action is specified
then this option is implied.

- - j ournal Show content of j ournal.
- - after dtime Only process entries deleted on or after

' dtime' .

- - before dtime Only process entries deleted before
' dtime' .

Actions:
- - inode ino Show info on inode ' ino' .
- - block blk Show info on block ' blk' .
- - restore- inode ino[, ino, . . . ]

Restore the file(s) with known inode
number ' ino' . The restored files are
created in . /RECOVERED_FILES with their
inode number as extension (ie,
file. 12345) .

- - restore- file ' path' Will restore file ' path' . ' path' is
relative to root of the partition and does
not start with a ' /' . The restored file is
created in the current directory as
' RECOVERED_FILES/path' .

- - restore- files ' path'
Will restore files which are listed in the
file ' path' . Each filename should be in
the same format as an option to - - restore-
file, and there should be one per line.

- - restore- directory ' path'
Will restore directory ' path' . ' path' is
relative to the root directory of the file
system. The restored directory is created
in the output directory as ' path' .

- - restore-all Attempts to restore everything.
- j j ournal Reads an external j ournal from the named

file.
- b blocknumber Uses the backup superblock at blocknumber

when opening the file system.
- B blocksize Uses blocksize as the block size when

opening the file system. The number
should be the number of bytes.

- - log 0 Make the program silent.
- - log filename Logs all messages to filename.

- - log D1=0, D2=filename Custom control of log messages with comma-
Examples below: separated list of options. Dn must be one

of info, warn, or error. Omission of the
- - log info, error ' =name' results in messages with the
- - log warn=0 specified level to be logged to the
- - log error=filename console. If the parameter is ' =0' , logging

for the specified level will be turned
off. If the parameter is ' =filename' ,
messages with that level will be written
to filename.

- o directory Save the recovered files to the named
directory. The restored files are created
in a directory named ' RECOVERED_FILES/' by
default.

Linux Anti Oops: How To Undelete Files
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While this information is helpful, it really doesn’t tell you how to run extundelete.
For that, you’ll need to refer to the information at the end of the aforementioned
README file, or the link to the man page. Or, just follow along with me for a bit
longer.

Before you can use extundelete, you will first need to unmount the volume that
holds the file(s) you want to recover. For example, if you have your /home
directory on a separate partition, issue the mount command without any
command line argument.

[parnote- toshiba@parnote- toshiba ~] $ mount
/dev/sda5 on / type ext4 (rw, noatime, acl, commit=0)
/dev/sda6 on /home type ext4 (rw, noatime, acl, commit=0)

That tells me that my /home directory is on /dev/sda6. If the file(s) that I want to
undelete are somewhere in my /home directory, I need to unmount the volume
first. Alternatively, you can mount the volume as read only. Alternatively, you can
remount the drive volume as read-only.

Unmount the drive: umount /dev/sda6

Mount the drive as read-only: mount - o remount, ro /dev/sda6

(Only use ONE of these commands, not both … unmounting the drive volume is easiest. )

Before proceeding, double check to make sure that the volume is indeed now
unmounted. To do so, rerun the mount command. The drive volume should not be
listed if it was properly unmounted.

Now, to undelete a specific file, you will need to know the full path and filename of
the deleted file. Execute the command like this:

extundelete /dev/sdaX - - restore- file path/to/the/deleted/file

You can also do something similar to recover deleted directories. Execute the
command like this:

extundelete /dev/sdaX - - restore- directory path/to/the/directory

If you don’t know or remember the entire path and filename, you can restore all of
the deleted files on the drive volume. Execute the command like this:

extundelete /dev/sdaX - - restore-all

All recovered files will be saved to a directory named RECOVERED_FILES/,
unless you specify a different directory with the -o option, followed by the
directory path.

It’s also doubtful that extundelete will be of much use to you with SD memory
cards, unless you’ve reformatted the SD card to use the EXT3 or EXT4
filesystem. However, it’s unlikely that you would do that, since most devices that
use SD cards (cameras, phones, tablets, etc.) expect to see either the FAT32 or
ExFAT filesystems in use – and the filesystem that is used to format nearly all SD
cards by default.

Still, extundelete definitely belongs in any Linux user’s arsenal of tools, and you
should add it to yours.

testdisk

If anyone were to say that testdisk is an easy and intuitive program to use, they
would be launched into orbit just by the intense laughter alone. It is neither the
easiest nor the most intuitive program to use, and its full range of features will be
understood only by the nerdiest of the nerds.

The description in Synaptic doesn’t add much to help crack the mystery of how to
run testdisk.

Tool to check and undelete partition

Tool to check and undelete partition. Works with the following filesystems:
* BeFS ( BeOS )
* BSD disklabel ( FreeBSD/OpenBSD/NetBSD )
* CramFS, Compressed File System
* DOS/Windows FAT12, FAT16 and FAT32
* HFS and HFS+, Hierarchical File System
* JFS, IBM's Journaled File System
* Linux Ext2 and Ext3
* Linux Raid

o RAID 1: mirroring
o RAID 4: striped array with parity device
o RAID 5: striped array with distributed parity information
o RAID 6: striped array with distributed dual redundancy information

* Linux Swap (versions 1 and 2)
* LVM and LVM2, Linux Logical Volume Manager
* Mac partition map
* Novell Storage Services NSS
* NTFS ( Windows NT/2K/XP/2003/Vista )
* ReiserFS 3.5, 3.6 and 4
* Sun Solaris i386 disklabel
* Unix File System UFS and UFS2 (Sun/BSD/...)
* XFS, SGI's Journaled File System

Linux Anti Oops: How To Undelete Files
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Not much more light is shed on how to use it, either, by running testdisk --help at
the command line:

[root@parnote- toshiba parnote- toshiba] # testdisk - - help
TestDisk 7. 0, Data Recovery Utility, April 2015
Christophe GRENIER <grenier@cgsecurity. org>
http: //www. cgsecurity. org

Usage: testdisk [/log] [/debug] [file. dd| file. e01| device]
testdisk /list [/log] [file. dd| file. e01| device]
testdisk /version

/log : create a testdisk. log file
/debug : add debug information
/list : display current partitions

TestDisk checks and recovers lost partitions

It works with :
- BeFS (BeOS)
- BSD disklabel (Free/Open/Net BSD)
- CramFS, Compressed File System
- DOS/Windows FAT12, FAT16 and FAT32
- XBox FATX
- Windows exFAT
- HFS, HFS+, Hierarchical File System
- JFS, IBM' s Journaled File System
- Linux btrfs
- Linux ext2, ext3 and ext4
- Linux GFS2
- Linux LUKS
- Linux Raid
- Linux Swap
- LVM, LVM2, Logical Volume Manager
- Netware NSS
- Windows NTFS
- ReiserFS 3. 5, 3. 6 and 4
- Sun Solaris i386 disklabel
- UFS and UFS2 (Sun/BSD/. . . )
- XFS, SGI' s Journaled File System
- Wii WBFS
- Sun ZFS

You can only run testdisk as the root user. But, just take a look at the large
number of different file systems testdisk works on!

Testdisk is menu driven, but that doesn’t make it much easier to run. To better
explain how to use testdisk to recover deleted files, we’ll resort to using a series
of screenshots, with an explanation of each.

To launch testdisk, simply issue the command “testdisk” on the command line as
the root user. Once it appears, select the log file you want to use. Your choices
are to either create a new log file, append the information to an existing log file, or
to not create a log file at all. Press “Enter” when you’ve made your choice with
the cursor keys.

Linux Anti Oops: How To Undelete Files
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Use the cursor keys to select the drive media that you want to scan with testdisk.
Since the laptop I’m writing this on only has one hard drive, the choice is rather
easy. Press the “Enter” key to proceed.

Next, select the partition table type for the drive you want to retrieve files from.
For most users, it’ll be the first choice of “Intel.” However, if you have an EFI GPT

partition (and I’m fairly certain you would know if you do), use the cursor keys to
make that selection. Press the “Enter” key when you have highlighted the proper
selection.

Use the up and down cursor keys to select the drive partition that contains the
files you want to recover. On my laptop, my /home partition is on /dev/sda6, so

Linux Anti Oops: How To Undelete Files
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this is the reason I’ve selected “6” from the list. This part initially had me
befuddled, until I realized that the numbers correspond with the numbers that
PCLinuxOS uses to identify my drive partitions. Once you’ve highlighted the
proper drive partition, use the left and right cursor keys to select the action you
want to perform. In our case, it’s the “List” option. Press the “Enter” key.

Use the up and down cursor keys to select the directory on the partition that
holds the files you want to recover (image bottom right, previous page). On my
laptop, those are in the “parnote-toshiba” directory. Press the right cursor key to
proceed.

Continue using the cursor keys to drill down through your directory structure to
select the directory that holds the files you want to recover.

Deleted files will appear in red text. Continue using the cursor keys to highlight
the file you want to recover. Press “c” to copy the currently selected file. If you

Linux Anti Oops: How To Undelete Files
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need/want to recover multiple files, highlight the files with cursor key, one by one,
press the “:” key to select the files, and then press “C” to copy all the selected
files.

Then, testdisk will ask you where you want to save the selected file(s). I created a
special directory on my computer, called “TestDel” to contain the files. Press “C”
when you’ve selected the directory where you want your recovered file(s) saved.

The only confirmation you will receive will be some green text six lines down from
the top. Even though the confirmation says “1 ok, 0 failed,” there is no guarantee
that the file was recovered properly. You should ALWAYS check the recovered
file, just to be sure that it was recovered properly.

To do that, you will have to go to the directory where you specified the recovered
file(s) to be saved. There, you will find the file in a directory structure that mirrors
the original path to the file(s) that you recovered. For example, for the highlighted
file above, it was stored here: /home/parnote-toshiba/parnote-
toshiba/Magazine/Jan2016/SSS/. For some unknown reason, testdisk did not
save the selected files in the selected directory. So, you will most likely have to
search for your recovered files. Most likely, they are in a similarly named directory
in your /home directory.

Also, all the recovered files will belong to the root user. As such, you may need to
change ownership of the recovered files back to the proper user.

Testdisk will also work equally well for deleted directories, too, allowing you to
recover entire directories that might have been mistakenly deleted. Just as with
individual files, deleted directories will also show up as red, and you recover them
exactly the same way.

Finally, to quit testdisk, press the “q” key multiple times, until you are finally back
at the command line prompt.

Full Monty . . .

Everything you might want or need –

plus the kitchen sink!

Linux Anti Oops: How To Undelete Files
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Once you’ve gone through the process with testdisk, it becomes easier. But your
first time is likely to be fraught with lots of trial and error – unless you follow the
directions here. I know my first time through testdisk was frustrating, and I found
myself becoming easily “lost” in the directory structures and partitions. That is,
until I figured things out and until I arrived on familiar turf with the directory
structure that I was intimately familiar with from my /home directory.

Testdisk definitely deserves a place in your file recovery toolbox.

photorec

Of all the Linux “undelete” utilities, photorec is the most well known. Like all the
others, photorec is a command line only program. The description in Synaptic
pretty much tells the whole story.

Data recovery software

PhotoRec is file data recovery software designed to recover lost files including
video, documents and archives from Hard Disks and CD-ROM and lost pictures
(thus, its 'Photo Recovery' name) from digital camera memory.

PhotoRec ignores the filesystem and goes after the underlying data, so it will still
work even if your media's filesystem has been severely damaged or reformatted.

There aren’t a whole lot of options for photorec, but don’t let that lead you to
underestimating how powerful photorec is. Photorec will often work when all the
other undelete utilities fail. As an example, I ran photorec on the hard drive in my
laptop. I filled up four (4) directories with recovered files that I had deleted LONG,
LONG ago. It came up with PDF files, image files, text files, music files, and a
whole assortment of files that I had deleted eons ago. And I didn’t even let it finish
running, stopping the process after only a couple of minutes. Many of the files
photorec was finding and recovering weren’t even listed in the other undelete
utilities as being available for retrieval. WOW! Plus, even more astounding is that
many of the files were complete.

When you think about it, it’s actually kind of scary at the same time that so much
of what I thought I had deleted was recoverable – things that I thought were long
gone, given the amount of time that had elapsed since I deleted them. If I can
recover those files, so can anyone else using the same simple methods
described here.

Just as with testdisk, photorec has to be ran as the root user. When you launch it,
you should see something like that pictured above. For this article, I inserted a
SD card from my hunting trail camera. It’s listed as /dev/sdb, and is selected in

the image above. Press the “Enter” key to proceed, or use the left and right
cursor keys to highlight the “Quit” option, then press the “Enter” key.

Also, if you’re thinking that photorec looks quite similar to testdisk, it’s because
the same people are responsible for both.

Linux Anti Oops: How To Undelete Files
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Select the partition that stored the files you want to recover (image lower right,
previous page).

Now, select the filesystem type where the files were stored. On my SD card, it’s a
FAT32 filesystem.

You now select whether you want photorec to scan the unallocated space on the
device, or if you want to extract files from the whole partition. Selecting “Free” will
retrieve only deleted files, while selecting “Whole” will retrieve all files, even those
still existing and accessible, as well as deleted files.

Photorec will then proceed to scan your selected drive/partition. It will display the

Linux Anti Oops: How To Undelete Files
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elapsed time since it started the retrieval, as well as an estimate on how long the
process will take. It also displays how many of each file type it retrieves. Pressing
“Enter” at this stage will stop the scan.

Just in case you pressed “Enter” by mistake, you’re given the chance to fix that
mistake (image on previous page, bottom right). Enter “Y” to quit the scan, or “N”
to resume the scan/recovery.

Your recovered files will be placed in sequentially numbered directories in your
/home directory named recup_dirXX, where XX is a number.

If you want more information on photorec, visit CGSecurity’s photorec wiki page,
where you’ll find a step-by-step guide. You can also visit the photorec man page.

If no other “undelete” utility makes it into your file management toolbox, you
should make sure that photorec ends up there. You might not need it today,
tomorrow, next week, next month, or even next year – but eventually, you WILL
need it at some point in the future. Like I said earlier, accidental deletion of files
occurs to all of us, sooner or later.

Retrieving open files

Occasionally, you might find yourself with a file open in a program, discovered
that you have accidentally deleted the file, but without an apparent or obvious
way to save the file again (yes, there are programs that don’t give you the option
to save an open file). If the file is open in a program that allows you to save data,
just resave the data to your hard drive. But if it’s the first scenario, all is not lost.

Thankfully, there is a way to save a file that is open in a program that doesn’t
have the option to save data. Like all the other methods listed here, you will have
to resort to using the command line.

Let’s assume we have a *.ogg file opened up for playback in xmms. Enter the
following at the command line:

lsof - c xmms | grep ogg

The “lsof -c xmms” lists all the files that are open by xmms, and pipes that list to
grep to list only the *.ogg files. The results will look something like the following:

xmms 9341 wachovia ogg 132r 8, 1 349758 1287631 /usr/bin/xmms
(deleted)

Now, we have all the information we need to save the file to a folder on our

The PCLinuxOS Magazine
Special Editions!
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computer, replacing the one that was accidentally
deleted. To do that, we use something like this:

cp /proc/9341/fd/132 ~/Music/my-music-
file. ogg

The “cp” is the copy command. The 9341 is the
process number provided in the output. The 132 is
the descriptor shown in the output. Finally, the
“~/Music/my-music-file.ogg” is the path and filename
that we choose to save the new *.ogg file to.

Now, you have resaved the open file that you
accidentally deleted.

Summary

Regardless of how careful you are, you will
eventually – at some point – accidentally delete a file
that you really need or want to keep. One of these
tools or methods can help save your assets, so to
speak.

There is yet another tool that can help recover
deleted files. It is called debugfs. I have skipped it in
this article due to its complexity. It makes testdisk
look like a walk in Nooby Park. If you have an
interest in or a need for debugfs, you can find a
rather full discussion of it here. I certainly cannot add
anything to what is presented there. The discussion
is WAY above my pay grade and far exceeds my
knowledge and understanding of such matters.

These tools also demonstrate how vulnerable your
data may still be, even after you think that you might
have deleted those files. Especially with photorec, I
was able to recover a literal ton of files that I thought
I had deleted months ago. That vulnerability should
be prominent in your mind, especially if you sell or
give away one of your used computers.

Next month, we’ll take a look at ways to securely
delete files so that they cannot be recovered, or to at

least minimize the amount of information that can be
recovered. With today’s heightened concerns about
the security of our private and personal data, it pays
to exercise caution.

Screenshot ShowcaseScreenshot Showcase
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Posted by tuxlink, on February 19, 2016, running Mate.
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by Meemaw

I don’t know about you, but I have been using
LibreOffice at work since 2009 and either
OpenOffice or LibreOffice at home since, well, since
before I converted my computers to Linux in 2006.

I have always loved this program and still use it
instead of MS Office at work, even though I had to
purchase Microsoft Office for access to a couple of
things my company uses. However, I have seen
places in LibreOffice where there is room for
improvement. LibreOffice 5.1 just came out in
February 2016, so I want to review some of the
improvements that have rolled out with this version.
One of the things I have noticed is that it starts
faster, especially starting a new Impress project,
which is very quick. The release notes state that the
menus have been reorganized. While this is
sometimes an annoyance, you may find that things
are in a more logical location now.

From LibreOffice’s website:

LibreOffice 5. 1 has also been improved “under the
hood, ” thanks to the work of hundreds of volunteers.
This translates into an open source office suite
which is easier to develop, maintain and debug.
Although this is not visible to users, it is extremely
important for enterprise deployments.

“LibreOffice 5. 1 is another step forward to fulfilling
our vision of an office suite tailored on user needs
and preferences”, says Bjoern Michaelsen, a
Director at The Document Foundation (TDF) and a
leading LibreOffice developer. “Since 2010, we have
gone through different development cycles to clean
up the code and make it more responsive. We are

now at a stage where we are close to providing a
better user interface. ”

“LibreOffice’s third development cycle is leading us
to a new user interface concept, where the user will
be able to choose the best layout of the elements on
the screen for his own needs, to leverage desktop
space in the best way” adds Jan Holesovsky, a
Director at TDF, and a member of the design team.

Let’s see a few new items:

Writer

LOWriter has a new menu called Styles - much of
the style formatting is in that one menu.

I’m pretty good at spelling, but I use Spell Check on
every document. Now it has a drop-down containing
all the dictionaries. I usually use only one, but if you
have a multilingual document, you won’t have to
change dictionaries and restart Spell Check (right,
top).

Yay! Mail Merge doesn’t need a database any
longer. You only need to specify the spreadsheet
you are using. While it works that way in mail merge
for letters, it seems you still need to create a
database to do labels.

Calc

LOCalc has a new menu called Sheet. Many of the
sheet commands (insert sheet, rows, columns for
example) are located in this menu.

LibreOffice 5.1: New Features, Faster Loading
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Selecting a row or column and right clicking to add
another always had the menu items Insert row
above and Insert column left. I always wondered
why you couldn’t insert a row below the one you
selected or insert a column to the right of the
selected one. Now it has both.

There is now a Statistics choice in the Data menu. If
you use statistics with your data, you will have more
choices than those in the status bar at the bottom.
The bar has Average, Sum, Count, Maximum and
Minimum along with a couple of others, but the
Statistics menu has several other choices for those
that need them.

Also, in Calc, your sheet can be exported as a png
image file as well as a pdf (center, top).

Impress

Impress has a new menu called Slide which has
many of the standard slide editing items.

Sometimes you want to create a certain design by
adding rectangles or squares, but you want each
one to be the same size. Create them, then right
click on the group of objects. The drop-down has
more tools than before - even arrangement and
sizing tools. The three rectangles in the image below
have been selected using <Shift> + Click, and now
can be made the same size using the Shapes >
Equalize Width and Shapes > Equalize Height
choices in the right-click menu. Pay attention,
though, as the shapes will be equalized using the
item that you chose last.

In the Sidebar, the Transitions section (2nd from the
top) has been changed a bit. I remember having a
list of transitions but not being sure which was which
until I chose one and let the preview play. Now the
window has an icon of each. They have also added
a few more transitions.

In the File menu, the Export command has changed
a bit. Now you can export any slide as an image file.
You have loads of format choices when exporting an
Impress slide or a Draw page:

Draw

Draw also has some new features. The right click
menu that we saw in Impress is also in Draw. You
can draw objects and equalize height or width in just
the same way. Also, if you haven’t used the sidebar
before, it has been changed a bit with new additions.
You can format many things directly from the
sidebar. See the very small rectangles out to the
side of each section title? Clicking on that opens the
formatting window separately and allows you to use
it instead of the sidebar (next page, top left).

In addition to the separate differences in each
document window, we have one for the main
window. You can now open a Google Docs or other

LibreOffice 5.1: New Features, Faster Loading
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remote document directly from LibreOffice. The
process is easy. The main LibreOffice page has a
new item in the left column called Remote Files.

Click on Remote Files, and a window will appear
asking you to designate the location for the remote
file (there is a dropdown with a few choices). (center
top)

You will have to provide your signon and password
for the location you choose. In the case of Google
Docs, you will choose Google Drive, provide your

signon and password, and can even label the entry
with a meaningful label. Click OK.

Next, you will see another window with your chosen
location and a list of the files it contains:

Choose the document you want to open. It will take
a bit longer to open than one that is stored on your
hard drive, but not too much longer. In my
experience, some files don’t open correctly. I opened
a remote file with several images, and not all of them
were there when it was loaded. I'm sure they will get
it fixed.

If you decide to set up another location, you will get
the signon screen for your first. You can click on
“Add service” at the top right of the window, and
proceed from there.

These are only part of the changes that have been
made. To see the whole list, the release notes are
here. YouTube videos here will show you many of
the new features of Write, Calc and Impress. I like all
the new features and look forward to even more.

A magazine just isn't a magazine
without articles to fill the pages.

If you have article ideas, or if you
would like to contribute articles to the

PCLinuxOS Magazine,
send an email to:

pclinuxos.mag@gmail.com

We are interested in general articles
about Linux, and (of course), articles

specific to PCLinuxOS.

LibreOffice 5.1: New Features, Faster Loading
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Posted by tbschommer, on February 15, 2016, running KDE.
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Offwe go into the wild blue ethernet

Rooting for the best OS yet

PCLinuxOS is a Texstar wonder

Against it we never would bet

Here's a toast to the man who leads us

Always giving something new

Don't forget the users too

Nothing can beat the PCLOS crew

Offwe go into the wild blue ethernet

Away from that Window's threat

Download PCLinuxOS

Burn it to a diskette

Give a cheer for the man who leads us

A Linux hero hear our roar

He always gives so much more

It's PCLinuxOS we adore
MP3 OGG

ms_meme's Nook: Off We Go

http://pclosmag.com/html/Issues/201603/files/offwego.mp3
http://pclosmag.com/html/Issues/201603/files/offwego.ogg
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by oldfrt

I have been running an old desktop for about 12
years now, but I am afraid that its time has come to
go. If I looked at something on YouTube, the CPU
showed 100% and the video was hard to watch. For
most other things, it served its purpose. By chance,
my daughter-in-law was discarding her desktop as
she now uses her laptop. She acquired it when she
was taking a Multi Media course at college. It is a HP
Compaq Media Center M7000 running Window
Media Center XP. It has lots of goodies: a
considerably faster CPU, 2 DVD R/W, a built-in TV
FM tuner, and many odd HP interface connectors. I
decided to keep a diary of my adventures in
conversion from my old box to this new one. Please
enjoy.

I believe there are two kinds of 'stuff' in the system.
There is system 'stuff' and user 'stuff.' I believe if I
install a current operating system and then create
my user ids, I should be able to copy the /home/user
info from the old drive to the new drive. Hopefully, all
the data for each user will be intact. I am not sure
about system 'stuff' however. I am going to make a
list of what system information I will need.

When I first checked the installed HD, it said it was a
280 GiB SATA but there was a recovery partition of
10 GiB. When I pulled the HD out of the computer, it
is stamped as 300 GiB SATA. I was originally going
to replace it with a 500 GiB HD, but after some
thought, I think I will leave the 300 GiB HD in there.
There is room to put another HD, and it can be
either an IDE or SATA. I think I will take my 500 GiB
IDE drive out of my old box and put it into the new
one.

The original plan was to install the latest version of
PCLinuxOS on the new SATA drive, mount the old
IDE onto the new machine, and copy everything
over to the new SATA drive. I thought there was an
IDE port on the new machine, but there isn't (RATS),
so that plan is dead. I thought I could use my
external USB device (you mount an IDE drive inside
and it attaches via USB to your system) to attach the
old IDE drive to the new machine. After some
messing around, I also abandoned the USB device.
For some reason, it would not recognize the IDE
drive, and I didn't want to start trying to figure out
why. The plan now is to just install the current
PCLinuxOS on the current 300 GiB drive.

I also have a Windows machine on my home
network, which I can access from my Linux machine
via Smb4K. So, I copied all my data files from my
user ids to a backup folder, one for each user, onto
my Windows machine.

On the PCLinuxOS main page, there is a link to get
PCLinuxOS. I used that link and created a bootable
DVD. I then proceeded to install that version onto
the new hard drive. Much to my surprise, I found out
that the ISO is dated 2014, and when installed it
showed over 800 updates. After asking on the
forum, I was pointed to a much newer ISO, which is
dated December 2015. When that was installed,
there were only about 40 updates.

I now have a good version of the operating system,
and it is up to date. The next thing was to set each of
my user ids on the new system. After I created a
new user id, using the same id, password, and
number on the new machine, I then copied all the
user data from the Windows machine to the new
Linux machine. I did find two problems. There are
two folders which you should NOT copy over, tmp
and desktop. If you do happen to copy them over,
when the user id trys to start, you will get an error
message and the user id will not start. After some
investigation, I found that if you use the desktop
folder that was created for the new machine, then
install the other user folders, the user id will be fine.
Since I did not copy over the .tmp file, the system
will create a new .tmp file, so that is not an issue.

I was working on getting my primary userid set up
and something happened while I was working in the
panel adding widgets. I got a plasma error message
and then the screen went black. I logged out and
logged back into my root id and it ran fine. I then
tried my failed user id again but the same thing
happened. I got a plasma error and then a black
screen. I did some searching in the forum and found
that either I could delete the user id and add it back
in again (I have a ton of data so I’m not too thrilled
with that idea), or simply go to home/userid/.kde4
and remove the .kde4 folder. When the userid starts
again, it will rebuild .kde4 and my data should be

An Upgrade Story For Your Reading Pleasure
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intact. I just renamed the folder .kde4 and sure
enough the userid came back with all my data.
However, it used a default desktop and it is a bit
different from the ones installed by PCLinuxOS. A
brand new .kde4 folder had been created. I had to
do some customization and messing around but it is
quite useable so I am leaving it alone.

I made a list of applications that I had installed on
top of the original system. I had to install Gramps,
Kompozer, PysolFC, along with some others. There
are a couple of applications that do not provide any
backup/restore function, so you have to play a bit.

PySolFC Freecell – I love to play this game. On the
new system, the stats were reset to 0 and I wanted
to keep my old stats. I found that in directory
home/userid/.PySolFC, there were 3 files called
comments.dat, options.cfg, and statistics.dat. I
copied them over from my old machine and all my
won/lost statistics were now in the new machine.

Thunderbird Mail – I could not find any export
function, so the next question is how do I transfer my
mail folders? There is an import function. However, it
is looking to convert another mail client to
Thunderbird, and there is no mail client on the new
machine. After some searching on the Internet, I

found that in home/userid/.thunderbird/(some kind of
key).default/mail there is the following: a folder
called 'Local Folders' (the pop location of my mail
provider), and a file (the pop location of my mail
provide).msf. I copied the two folders and .msf file to
my new machine and then all my folders appeared
with my saved mail.

Digikam – I have a large number of Digikam
images. There is an import/export function available
in Digikam. However, I thought it might be easier to
just move all the image folders to my windows
machine then move them back to the new machine.
I moved all the files including the associated .db
files. There are two, one called digikam4.db and
thumbnails-digikam.db. When I started Digikam on
the new machine I received errors regarding the
data files and errors not finding the pictures. After
some investigation, I found an item suggesting to
delete these files found in any folders. When you
restart Digikam, it looks for those files, and if it
cannot find them, it rebuilds them. Once I did that
then Digikam came up (it took awhile to rebuild the
.db files). Now, I can access all my pictures.

KOrganizer – This seemed like a pretty simple
thing. Just use the *.ics files from the old machine
and I should have all my calendar events copied
over. I forgot about the colours bug. There is a bug
in KOrganizer which says that the colour of the
event is lost when you close the calendar. This is a
known problem, and the solution for me was to copy
over from the old machine home/.kde4/share/config
a file called korganizerrc. This file contains all the
events and their associated colours. Once I did that,
then my calendar is now set up like it was before.

AdobeReader – I have been using AdobeReader for
a long time but to my surprise it is no longer
available. I had to do some searching for a new pdf
reader and settled on PdfViewer, which does exactly
what I need.

Gpass – Password Manager. In home/userid/.gpass
there is a file called passwords.gps. This file

contains all the accounts and passwords in
encrypted form. I copied this file from the old
machine to the new machine and all my passwords
were then available.

LibreOffice – when using Writer, there are missing
lines of text. This is an issue that I had on the old
machine. I had to update etc/x11/xorg.conf with the
following, and now there are no issues with Writer:

Section "Module"
Load "v4l" # Video for Linux
Load "dri2"
Load "glamoregl"

EndSection

Section "Device"
Identifier "device1"

VendorName "Advanced Micro Devices,
Inc. [AMD/ATI] "

BoardName "ATI Radeon HD 4870 and
earlier"

Driver "ati"
Option "DPMS"
Option "RenderAccel" "off"

EndSection

I still have a few things to do, but they are things that
can be done when time permits. I acquired a second
SATA drive, so I just need to install and format it.
This system also has a Media keyboard with some
interesting options. For example, there are two eject
keys for the DVD's, so I have to do some
investigating into how to set up the keyboard, but
that's a story for another day.

I hope you enjoyed this small story and I hope it
helps in some small way.

DOWNLOAD

Mate Desktop

An Upgrade Story For Your Reading Pleasure
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l inuxfordummies.org

There Are No Stupid Questions1. All the contents of The PCLinuxOS Magazine are only for general
information and/or use. Such contents do not constitute advice
and should not be relied upon in making (or refraining from
making) any decision. Any specific advice or replies to queries in
any part of the magazine is/are the person opinion of such
experts/consultants/persons and are not subscribed to by The
PCLinuxOS Magazine.

2. The information in The PCLinuxOS Magazine is provided on an
"AS IS" basis, and all warranties, expressed or implied of any
kind, regarding any matter pertaining to any information, advice
or replies are disclaimed and excluded.

3. The PCLinuxOS Magazine and its associates shall not be liable,
at any time, for damages (including, but not limited to, without
limitation, damages of any kind) arising in contract, rot or
otherwise, from the use of or inability to use the magazine, or any
of its contents, or from any action taken (or refrained from being
taken) as a result of using the magazine or any such contents or
for any failure of performance, error, omission, interruption,
deletion, defect, delay in operation or transmission, computer
virus, communications line failure, theft or destruction or
unauthorized access to, alteration of, or use of information
contained on the magazine.

4. No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation. All trademarks are the property of their respective
owners.

5. Certain links on the magazine lead to resources located on
servers maintained by third parties over whom The PCLinuxOS
Magazine has no control or connection, business or otherwise.
These sites are external to The PCLinuxOS Magazine and by
visiting these, you are doing so of your own accord and assume
all responsibility and liability for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by
users. The PCLinuxOS Magazine accepts no responsibility for the
content, accuracy, conformity to applicable laws of such material.

Entire Agreement
These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or
oral, regarding such subject matter.

Disclaimer

Posted by present_arms, on February 06, 2016, running Trinity.

http://www.fsf.org
http://linuxfordummies.org/
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by daiashi

About The Game

Breach & Clear is a deep tactical strategy
simulation. Build your Special Operations team, plan
and execute advanced missions, and own every
angle. Choose between US Army Rangers,
Germany's KSK, Canada’s JTF2, UK SAS, and
more. Take on a variety of foes with different skill-
sets and abilities. Learn to approach, engage, and
dominate your opponents through superior tactics
and training. The Steam version of Breach & Clear
includes all the premium content from the original
mobile game at no additional cost.

Build your arsenal with thousands of gun
combinations, and specialize each soldier with a
combination of perks, tactics, camo, armor, and
inventory all tailored by you. Tune your load-out with
consumables like UAV Drones and Breaching
Charges that can change the course of battle!

Many maps have multiple entry points. When these
points are presented to you you can split your team
up at different entry points. This is a click and move
game. Click where you want your soldier to go and

what direction to face. You can even frag or stun
grenade your entry room. Some maps are in office
buildings, and others are outside or streets.

As you progress through the game, your characters
earn points to put toward things like awareness, aim,
etc. Gun customization similar to Call of Duty, from
sites to grips, it's all there. The game is similar to
Door Kickers without the cartoon visuals. The screen
has top down view and also 3rd person view. It will
go into line of sight mode randomly when delivering
a kill shot or at the end of round. All in all, it is a fun
game to start and finish with. For the zombie in you,
there is also a zombie expansion available.

System requirements:

Fully updated PCLinuxOS and Steam

Hardware:

Processor: Core 2 Duo or equivalent
1.5 GHz or higher

Memory: 2 GB RAM
Graphics: OpenGL 3.0+ compatible video card
Storage: 3 GB available space

About The Company

Based in Kentucky, Gun Media is a publisher of
interactive entertainment comprised of industry
veterans with unique and complementary
backgrounds. The mission of Gun is to build fresh
and exciting interactive experiences for a wide range
of platforms and gamers. The team shares a vision
that game development is not just the creation of a
product, but the blending of art, design and
technology to create an experience that engages
and entertains players from all over the world.

Mighty Rabbit Studios is an independent game
developer based in Holly Springs, NC. They focus
on making unique, awesome game experiences
unlike anything else on the market. Their first major
release was Saturday Morning RPG, an episodic
role-playing game set in a world inspired by 1980s
Saturday morning cartoons. Saturday Morning RPG
won praise from many critics and has been enjoyed
by hundreds of thousands of nostalgia hungry
gamers around the world.

Mighty Rabbit Studios developed, programmed,
animated and created 2D and 3D art for Breach and
Clear.

Some Gameplay Screenshots

Game Zone: Breach & Clear
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Getting It To Run

Install Steam (if you don’t have it installed already),
then start it. You will need to create a new account, if
you do not already have one. Once you have Steam
up and running, go to the store tab. Click on the
Linux tab if you wish and search for breach&clear.
There is no demo for this game. It is available for
purchase only. Normally, it is $14.99, without
expansions. If you have updated your system,
including graphics drivers, you should be good to go.

http://store.steampowered.com/app/266130/

Full Monty . . . Everything you might want or need –

plus the kitchen sink!

Game Zone: Breach & Clear

http://www.pclinuxos.com/?page_id=1413
http://chimpbox.us
http://www.jupiterbroadcasting.com/tag/linux-action-show/
http://store.steampowered.com/app/266130/
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as told in their own words

What is your name/username?
My name is Andreas Birkel. My username is 'aguila',
which is Spanish for “eagle.” I've been air travelling
world wide a lot in the past, plus I like the concept of
eagles – freedom over comfort.

How old are you?
I'm 45 years.

Are you married, single?
I've been married for ten years this May.

How about Kids, Grandkids ?
We have two kids, a boy of eight, and a girl of nine.

Do you have pets, what is your favorite?
No pets. When I was a kid, we had a dog.

Are you retired, stil l working and if working, what
do you do?
Since my education as an industrial management
assistant, I've been working in sales. I've been
working in a couple of industries - import and
wholesale fruit, then import of diamond tools for
construction, export sales for one of the world's
biggest hardwood sawmills, then marketing and
worldwide sales of decorative glass coatings for a
coatings factory. Today I'm a travelling salesman in
chemical raw materials (mainly for detergents),
working for a wholesale company.

All along the way, I've been holding on to some
principles (only consumable material, medium-sized
companies, stay in the area). Who knows what lies
ahead?

Where do you call home? What is it l ike? IE:
weather, scenery
We live right in the center of Germany, in Bad
Hersfeld, Hesse. Lots of green (forest and
agriculture), small towns (10,000 to 80,000
inhabitants) and lots of villages. It’s a very nice area
with a temperate climate, up to 30° C in the summer,
and rarely 20° below zero Centigrade in the winter.

Where did you go to school and what is your
education level?
I got a university-entrance diploma, but decided to
take an apprenticeship first, and maybe get a
university degree afterwards, which for various
reasons I didn't. But I took evening courses and
learned Spanish and Portuguese, and I have really
enjoyed working in export for 10+ years now.

What kind of things you like doing? hobbies,
travel, fishing, camping?
I really like to ride a road bike. This year I joined the
local bicycle club and took part in a couple of
everyman races. I hope to do some more next
season.

Apart from that, I like working out, photography, and
computers (I'm not a geek though). Well, and spend
time with my wife and kids, of course.

Why and when did you start using Linux?
I've always been interested in computers since I got
my Commodore C64 back in the 80s, but never got
to a deeper level of hardware tinkering or
programming. In 2005, when we had a reasonably
fast internet connection, I got interested in Linux
after reading about it in magazines. So I fired up
some Live CDs. On starting a Knoppix Live CD, the
main board of my desktop died. After that, I didn't
look at Linux for about a year or two.

When I got my first laptop in 2007, it had Windows
Vista installed. That crap died on me twice during
system updates, so I started to look at Linux again.

First, I installed OpenSuSE and dual booted, but I
wasn't convinced yet. I then switched to Fedora,
which seemed better, but lacked all of the non-free
drivers and software. When I searched some more, I
found PCLinuxOS. I installed it on my second laptop
and was really hooked.

Today, all the computers under my control (three in
our home, one at my mother-in-law's, and two at my
parents) exclusively run PCLinuxOS.

PCLinuxOS Family Member Spotlight is an exclusive,
monthly column by youcantoo, featuring PCLinuxOS
forum members. This column will allow "the rest of us" to

PCLinuxOS Family Member Spotlight: aguila
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get to know our forum family members better, and will
give those featured an opportunity to share their
PCLinuxOS story with the rest of the world.

If you would like to be featured in PCLinuxOS Family
Member Spotlight, please send a private message to
youcantoo, parnote or Meemaw in the PCLinuxOS forum
expressing your interest.

Screenshot ShowcaseScreenshot Showcase

Are viruses,
adware, malware &
spyware slowing
you down?

Get your PC back
to good health
TODAY!

Get

Does your computer run slow?

Are you tired of all the "Blue Screens
of Death" computer crashes?

Download your copy today! FREE!

Posted by Phused, on February 04, 2016, running KDE.

PCLinuxOS Family Member Spotlight: aguila

http://www.pclinuxos.com/?page_id=10
http://pclinuxos.com/?page_id=7
http://pclostalk.pclosusers.com
http://pclosmag.com
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Editor’s Note: Tip Top Tips is a monthly column in The
PCLinuxOS Magazine. Each month, we will feature – and
possibly even expand upon -- one tip from the PCLinuxOS
forum. The magazine will not accept independent tip
submissions specifically intended for inclusion in the Tip
Top Tips column. Rather, if you have a tip, share it in the
PCLinuxOS forum’s “Tips & Tricks” section. Your tip just
may be selected for publication in The PCLinuxOS
Magazine.

This month’s tip comes from PCLinuxOS forum
member jogurtmen.

PCLinuxOS for now is working very nicely on older
computers, but obsolete hardware is less supported
by newer software. Most problems are older CPUs
that do not support SSE2. On my older computer
(AMD Athlon XP 2800+, GeForce 6200, DDR 2GB),
it has PCLinuxOS MATE installed, and the problem
was to use a more recent Flash player plugin. I had
to use version 11.1 ... which was not functional on
some sites. Seeking the internet solution to
circumvent the lack of a CPU that does not support
SSE2 on the Mageia Wiki, I found a solution to this
problem. This is the solution I have tested, and it
works perfectly. Of course, it is not possible to install
the latest version of the Flash Player plugin (version
11.2.202.235 already), but this is a big improvement
over the older version of the Flash Player Plugin.

The procedure is as follows:

The 11.2 flash plugin included in Google Chrome 19
for Linux was compiled for SSE, and may be used in
Firefox or other browsers by machines with
processors that handle SSE.

To install the flash plugin from Google Chrome 19:

1. Uninstall the flash-player-plugin package

2. Remove any copies of earlier versions of
l ibflashplayer.so from /usr/lib/mozilla/plugins (or
/usr/lib64/mozilla/plugins).

3. Download l ibgcflashplayer.so (17MB).
http://www1.datafilehost.com/d/796ff3f2

4. You may check the integrity of the downloaded file
with md5sum libgcflashplayer. so. The expected
result is 58e48350459e8b12b3f1cba047184583.

5. Rename l ibgcflashplayer.so to
l ibflashplayer.so.

6. Copy l ibflashplayer.so to /usr/lib/mozilla/
plugins (or /usr/lib64/mozilla/ plugins).

That's it. It is not complicated, and it works without
problems.

I hope that this will be of benefit to people who still
have hardware 10 years old and over.

Source and more about this:
https://wiki.mageia.org/en/Flash_Plugin_Installation

A magazine just isn't a magazine
without articles to fill the pages.

If you have article ideas, or if you
would like to contribute articles to the

PCLinuxOS Magazine,
send an email to:

pclinuxos.mag@gmail.com

We are interested in general articles
about Linux, and (of course), articles

specific to PCLinuxOS.

Tip Top Tips: Installing A Newer Version Of
Flash Player Plugin To Older Computers & CPUs

mailto:pclinuxos.mag@gmail.com
http://www.pclinuxos.com/forum/index.php/topic,135980.msg1158396.html#msg1158396
http://www1.datafilehost.com/d/796ff3f2
https://wiki.mageia.org/en/Flash_Plugin_Installation
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Ingredients

3/4 cup butter
1 1/2 cups packed brown sugar
1/3 cup honey
1/3 cup whipping cream
1/4 cup water
2 teaspoons grated orange peel
3 tablespoons orange juice
1 vanilla bean, split, seeds scraped out

and reserved, bean discarded
1 cup pecan halves, toasted
2 loaves (1 lb each) frozen white bread dough,

thawed
1/4 cup packed brown sugar
1/4 cup granulated sugar
1 teaspoon ground cinnamon
1/4 teaspoon salt

Directions

1. In a 2-quart saucepan, melt butter over medium
heat. Add 1 1/2 cups brown sugar, and cook until
combined. Remove from heat. Stir in honey,
whipping cream, water, orange peel, orange juice
and seeds from vanilla bean. Cool 30 minutes. Pour
mixture in ungreased 13x9x2-inch pan. Scatter
pecan halves over top.

2. Roll out one loaf of dough into rectangle shape
about 14 inches by 6 inches. In small bowl, mix 1/4
cup each of brown sugar and granulated sugar, the
cinnamon and salt. Spread half of mixture over
dough. Roll dough tightly, and pinch seams closed.
Using serrated knife, cut into 1 1/2-inch pieces.
Place rolls cut side down in pan. Repeat with second
loaf remaining sugar mixture. Cover pan of rolls with
plastic wrap; refrigerate overnight.

3. Remove from refrigerator and let sit
30 minutes. Heat oven to 350°F. Bake
35 to 45 minutes or until golden brown.
Cool in pan 20 minutes. Cover pan with
platter, and carefully flip over.

OPTIONS: If you want to make these
the same day, instead of placing in
refrigerator overnight, leave out to rise
about 2 hours or until doubled in size,
and bake as directed.

PCLinuxOS Recipe Corner

Overnight Orange and Vanilla Bean Sticky Buns

http://www.linuxfoundation.org/
http://pclinuxos.com/?page_id=188
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Screenshot ShowcaseScreenshot Showcase

Support PCLinuxOS! Get Your Official

PCLinuxOS
Merchandise Today!

Linux Docs
Linux Man Pages

Posted by Orion, on February 02, 2016, running Xfce.

http://www.cafepress.com/pclinuxos
http://www.die.net/
http://www.dosgamesarchive.com/
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by Meemaw

I found a fun tutorial the other day that shows how to
make your text look like it is pushed up out of the
background.

Create a new page. It can be any size you want, but
mine is 640 x 400. You can use the Pattern choice
on your Bucket Fill or just open some sort of pattern.
The one I did above was the pattern Paper. The rest
of this tutorial will use a wood background. Add your
text as usual, setting the characteristics to your
liking.

Now we will copy the background texture onto the
text. With the text layer chosen, right click it in the
layers dialog and choose Alpha to selection. This
will outline your text. Now click on the background
layer, then click Edit > Copy. Then, click the text
layer, and choose Edit > Paste.

There is a floating layer above your text layer.
Choose that layer and click the anchor in the layers
dialog to anchor it to the text layer.

Create a new, transparent layer, then click back on
your text layer. Right click the text layer and choose
Alpha to selection. You will be able to see your text
again by the moving dotted lines. Click on the new
layer again, then go to Select > Grow. A box will
appear asking how much you want it to grow. You
can set it from 5 to 8 px, depending on the size of
your text, then click OK. Now choose your bucket fill
tool and change it to FG black, then click inside the
letters (right, top).

Now choose Select > All to select the whole layer,
then go to Filters > Blur > Gaussian Blur and
change the vertical and horizontal settings to 20 px,
then click OK (right).

This layer should be behind the text, so in the
Layers dialog, choose the text layer and move it to
the top.

GIMP Tutorial: Pop-Up Text
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Now we are going to add another effect to help our
text along. Right-click on the text layer on top and
choose Alpha to Selection. Then go to Filters >
Decor > Add Bevel. Change the setting to 5 px and
uncheck the two boxes in the Bevel window. Click
OK. You should see a tiny bit of a bevel on the
edges of the letters. Change to the Move tool and
move text layer up and left a tiny bit, then anchor it.
Now it looks as if it is popping out of the background.

If you are happy with the results, you can go ahead
and merge your layers and export your project.

I have found several tutorials about text, so we will
do more in coming issues.

Screenshot ShowcaseScreenshot Showcase

The PCLinuxOS
Magazine

Created with
Scribus

Posted by Meemaw, on February 14, 2016, running Xfce.

GIMP Tutorial: Pop Up Text

http://www.scribus.net
http://pclinuxos.com/?page_id=7
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SCRAPPLER RULES:
1. Follow the rules of Scrabble®. You can
view them here. You have seven (7) letter
tiles with which to make as long of a word
as you possibly can. Words are based on
the English language. Non-English
language words are NOT allowed.
2. Red letters are scored double points.
Green letters are scored triple points.
3. Add up the score of all the letters that
you used. Unused letters are not scored.
For red or green letters, apply the
multiplier when tallying up your score.
Next, apply any additional scoring
multipliers, such as double or triple word
score.
4. An additional 50 points is added for
using all seven (7) of your tiles in a set to
make your word. You will not necessarily
be able to use all seven (7) of the letters in
your set to form a “legal” word.
5. In case you are having difficulty seeing
the point value on the letter tiles, here is a
list of how they are scored:

0 points: 2 blank tiles
1 point: E, A, I, O, N, R, T, L, S, U
2 points: D, G
3 points: B, C, M, P
4 points: F, H, V, W, Y
5 points: K
8 points: J, X
10 points: Q, Z

6. Optionally, a time limit of 60 minutes
should apply to the game, averaging to 12
minutes per letter tile set.
7. Have fun! It's only a game!

SUDOKU RULES: There is only one valid solution to each
Sudoku puzzle. The only way the puzzle can be considered
solved correctly is when all 81 boxes contain numbers and the
other Sudoku rules have been followed.

When you start a game of Sudoku, some blocks will be prefilled
for you. You cannot change these numbers in the course of the
game.

Each column must contain all of the numbers 1 through 9 and
no two numbers in the same column of a Sudoku puzzle can
be the same. Each row must contain all of the numbers 1
through 9 and no two numbers in the same row of a Sudoku
puzzle can be the same.

Each block must contain all of the numbers 1 through 9 and no
two numbers in the same block of a Sudoku puzzle can be the
same. D

o
w
n
lo
a
d
P
u
z
z
le
S
o
lu
ti
o
n
s
H
e
re

Possible score 224, average score 157.

PCLinuxOS Puzzled Partitions

http://pclosmag.com/html/Issues/201603/files/2016-03-PuzzleSolutions.pdf
http://www.scrabblesite.com/scrabble/rules/
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1. great to record ideas

2. measuring tape is one kind

3. a soft surface for your mouse and hand

4. to enclose your outgoing letter

5. rings or pockets inside to organize things

6. makes mistakes disappear

7. covers mistakes

8. usually has the company letterhead on it

9. holds papers together temporarily

10. good to install a PCLinuxOS iso on

11. records your appointments

12. used to insert staples into hard things

13. to store all your information

14. no printer functions without this

15. to stick on the envelopes

16. temporary reminders which can be

placed almost anywhere

Download Puzzle Solutions Here

PCLinuxOS Puzzled Partitions

PCLinuxOS Crossword Puzzle: March 2016
Office Supplies

http://pclosmag.com/html/Issues/201603/files/2016-03-PuzzleSolutions.pdf


PCLinuxOS Magazine Page 36

binder

calendar

copy paper

envelopes

eraser

file cabinets

file folders

flash drives

folder labels

mailing labels

mousepad

notepads

paper clips

pen

pencil

printer ink

push pins

ruler

scotch tape

staple gun

staples

stationery

sticky notes

thumbtacks

whiteout

Download Puzzle Solutions Here

K T I I T C E C K I H Q K N I R E T N I R P J J R V O O O F

S A S N Q M K U Z U X O C L Q T T S F O L D E R L A B E L S

S Z R S W C L M S E P A T H C T O C S L P V W L R O Q S W Q

E G V K B P X U K T V R V O U P L E K W G T H L Z C E O R V

T M W C Y Q L L Q N A F A H V I L X X I V C J A K Y X F M X

O K L A D X U C S T R T H I C V L N U L Y O T U P U N H Y N

N Q F T I A O K J B H Q I J G U C R U W G V D M G H S M S J

Y W X B E S K A F E W V V O Y V B A O H M M E R Z C B L M C

K T D M I P B Q F S C O K B N Q A H U J F G N C L X I V X J

C Z O U N J F I L E C A B I N E T S C U E U X K K J D I R V

I E W H I S H N A M E I O T E G R B E E A T X G L E E P K E

T A T T M F G C S O A S M T P J O Y R G K V G H F Y B H V C

S F U B P Q P J H M Y I D S Y Y D J H P A R O G M K M C N F

Y K T M J P C R D F L T L J M P B A R Z M Y O S U E E Q G F

X F G Z M T I U R I Q R L I C O Z O N A N I W L X X R Q Q T

Z P A P E R C L I P S Z E G N W U P L J T M D A L I U T I M

U N O A P K U E V P Q C U P U G L S D S W B C D C B B Q A D

B I S V L U J R E B U T H U A O L B E S O T K M N U G Y J H

L L B L N X S Z S P G Q P S H P W A M P K F R R J E Z I A S

O F H L G D L H E X S J H I O A Y R B I A C P L H X X N R Z

D J I P I P H R P Q V R P F A B O P X E M D V K A P S D Z U

V L B L J X A E V I H E R C J N B V O W L W C H E Y B V Q V

G N X V E S Z R W D N O S R G C X I T C H S T A P L E G U N

D H I G E F D D U C V S V O J L T V N V I I F H L I C G O E

C J Z R D W O H I I G Q S K I F F V I D M K T U X Q C G E W

W K M C U J L L Y G Q Q A E N V E L O P E S H E M H I B U K

A D N V U C X E D Q S F L U P T V C Y G D R M C O Y K H B N

I E U J U S V H Q E S T A P L E S S C M X W S F O U B P Q V

J F Y H L W V S Y I R A D N E L A C S D A P E T O N T R F A

W X Q J K F P E D Z N S Z Y T Z V H J P V P S U B M Q F L T

PCLinuxOS Puzzled Partitions

Office Supplies Word Find

http://pclosmag.com/html/Issues/201603/files/2016-03-PuzzleSolutions.pdf
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Posted by jogurtmen, on February 4, 2016, running KDE. Posted by dockmackie, on February 11 , 2016, running KDE.

Posted by cstrike77, on February 21 , 2016, running KDE.Posted by crow, on February 23, 2016, running KDE.

More Screenshot Showcase




